
GEOSCAN
SCAN GEO
GEOSCAN
SCAN GEO
GEOSCAN
SCAN GEO
GEOSCAN
SCAN GEO
GEOSCAN
SCAN GEO
GEOSCAN
SCAN GEO
GEOSCAN
SCAN GEO
GEOSCAN
SCAN GEO
GEOSCAN
SCAN GEO
GEOSCAN
SCAN GEO
GEOSCAN
SCAN GEO
GEOSCAN

Graphics Facilities

Shade plots (grey scale or colour)
Trace plots (stacked or 3D style)
Dot-density and Pattern plots
Relief plots (artificial sun)
User-defined shade palettes
Overlay grid lines and numbers
Auto refresh after edit or process
Print out at any scale
Save graphic as bitmap for export
Publishing mode
Animation

Environment

Graphics, data, history & details views
Full process and edit history archive
Import data from other software
Export data to other software
Data download from Instruments
Support for FM256 Dual Gradiometer
Keyboard input
Generate stacked Pseudo-sections
Extensive user defined options
Extensive default operation offered

Processing Facilities

High and Low Pass Filters
Periodic Defect Filter
Zero Mean Filters
Destagger Filter
Interpolation
Edge Matching
Despiking & Median Filter
Statistical & Spectral Analysis
Numeric Operations
Powerful Cut & Combine
Non-linear process functions for 
improved data quality
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Introduction

GEOPLOT
Version 3.0

Environment
 Geoplot 3.0 retains all the functionality of the previous DOS version but adds the flexibility and 
convenience of a Windows environment. For example you can still navigate using the keyboard, menus and 
shortcut keys alone, essential for field use when a mouse or other pointing device is hard to use. However, the 
new Windows version brings the extra versatility of a mouse pointer and fast access to commonly used features 
using the new toolbars for process functions, graphics and drawing. You can identify data values by scanning the 
mouse over a graphics plot or select new graphics or process areas using the mouse. A typical opening screen 
consists of : a standard menu at the top, a horizontal toolbar just underneath which gives fast access to common 

 Geoplot 3.0 is a Windows program for the processing and presentation of geophysical data collected from a variety of 
instruments including : resistance meters, gradiometers, magnetometers, EM instruments, magnetic susceptibility instruments. 
Processing facilities include : high pass, low pass, median & periodic filters, spectrum and variance analysis, despiking, interpolation, 
edge matching, zero mean traverse correction, destagger correction, several numeric functions and a powerful cut and combine 
function for combing data sets mathematically. A record of every edit and process is maintained with each data file. Graphics may be 
produced as shade plots (grey scale or colour), trace plots (stacked profiles or 3D), dot-density or pattern plots and may be printed out 
at any scale or saved as bitmaps for use in other software packages. A publishing mode is included which allows you to combine many 
graphics images, text, drawn objects etc. Data can be imported and exported, allowing data exchange with other software packages.
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menu items, a process toolbar to the left, a drawing toolbar to the right, 
status bar at the bottom, and floating full statistics and latest history forms 
which can be invaluable aids for processing data. The View menu lets you 
turn toolbars etc on and off, though some control is also replicated on the 
horizontal toolbar.

 There are four views you can have of opened data : graphics 
view, data view, history view and file details view. You can easily swop 
between views using the View menu or function keys. A fifth view, 
publish, is available for creating a published presentation of your graphics 
plots. A hard-copy can be made of all the views using the File menu. 
There is extensive control in the Options menu over how Geoplot operates 
and your preferred defaults for different views and forms. For example 
default plotting parameters, and default numeric resolution in the data 
view can be set. You can define what your preferred view is when you 
load new data  and also if previous plotting parameters or default ones are 
to be used. Many other options can be defined.

 Data is handled in grid, master grid or composite format. A 
master grid defines how the individual grids lie in relationship to one 
another and can be used to combine individual grid data files into one file 
called a composite. Grids and composite files have associated with them 
an edit and process history respectively, as well as dimensional and other 
file information details. Input templates, which document data collection 
details and user comments, make data input rapid and easy to accomplish, 
and can avoid errors in the field. Files can optionally be date stamped 
when input, in either European or USA format.

 Data may be downloaded from Geoscan instruments via the 
RS232 port, manually input via the keyboard or imported via batch file 
transfer. Raw grid data downloaded from instruments is write-protected, 
preventing loss of data whilst in Geoplot. Imported data can be stored in 
grid or composite data format and a variety of input formats are 
recognised, including ASCII, XYZ and spreadsheet, so that data from 
instruments other than those made by Geoscan Research can be handled. 
Data can also be batch exported in a variety of formats including plain 
ASCII, XYZ (comma, space or tab separated), spreadsheet, Geosoft, 
Surfer grid files (ASCII and binary) and Grass for GIS. Generating direct 
Surfer grid files within Geoplot can save considerable time when using 
Surfer's facilities. Pseudosection data can be exported in Res2dinv format 
which provides inversion facilities using the least means squares method.

 Usually you will use SVGA screen resolution or higher for 
desktop work but the forms have been designed for VGA use too, which 
can be extremely useful for data download in poor lighting conditions or 
where older laptop computers with VGA LCD's are to be used.

 The file menu also has facilities for : combining several 
composites into one large composite, creating blank composites for 
complex data manipulation, merging FM256 dual gradiometer data, 
merging multiplexed parallel 0.5m/single 1.0m Twin data and generation 
of stacked pseudo-sections from expanding Twin array data sets.

 Whenever an edit or process function is applied to data the 
default is to immediately update the current view, be it graphics, data, 
history or file details. The floating history and statistics forms are updated 
too. You can, if you wish,  turn off automatic graphics update. The Edit 
menu allows you to Flip Horizontal, Invert Traverse mode, Swop 
traverses, Shift data and directly change grid data. The Edit menu also 
allows you to change the North direction, change the Units and rotate both 
grids and composites. You can additionally document the recorded edits 
and processes by adding, inserting or deleting comments in the file 
history. 

Data view

History view
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Graphics
 Four graphics presentation types are provided : shade, trace, dot-density and 
pattern. Shade plots can have between 2 and 234 different shades of grey or colour. Trace 
plots represent data by a series of line graphs side by side. The data may be viewed from all 
four sides, and the trace angles adjusted to give a 3D style view. Dot-density and pattern 
plots represent data values by the number of dots within a cell plotted either randomly or in 
a systematic way. Plotting parameters can be entered in standard, clip, compress or relief 
mode, with default settings being defined in Graphics Options. Relief plots (artificial sun) 
are particularly effective at removing background resistance variations and present an 
almost photographic style quality (see adjacent figures). You can select a smaller portion of 
a graphics plot for display either by entering co-ordinates in the graphics parameter form or 
by selecting an area with the mouse. Plotting size varies between x 5 and x 1/32, providing 
a large dynamic range. You can magnify, reduce, zoom in or out at a point and pan in a 
graphics plot using either buttons on the toolbar or shortcut keys. A special toolbar button 
allows you to magnify x2 a small localised area of a plot (see figure).

 A range of shade palettes are supplied and you can create and edit your own (see 
page opposite). Each palette comprises one or more flooded regions and individual colour 
bands can also be superimposed anywhere on the palette. When in graphics view you can 
change the palette either by using the palette tools (next palette, previous palette, invert 
palette) or by bringing up the graphics parameter form. You can quickly display the Shade 
and Trace parameters forms by clicking on two special icons on the horizontal toolbar, or 
by choosing from the Graphics menu as normal.

Localised x2 
Magnification 
shade plot

Shade plot - Clip parameters

Shade plot - Relief parameters

Trace plot - hidden line on
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 Grid lines and numbers can optionally be superimposed on 
graphics plots, as well as your own user defined grid. As you move the 
mouse over a graphics plot its x, y co-ordinates are reported on the status bar 
(in both metres and reading units), along with the data value at that point. 
You can set any colour you like for the graphics screen background, dummy 
values etc. using the Graphics Options. Plot details can optionally be 
displayed on the right-hand side of the screen which includes palette or trace 
scale-bar, distance scale-bar, plotting parameters, direction of first traverse 
and histogram. The resolution of the numbers on the palette scale-bar can be 
controlled using the Graphics Options form. If you apply the Spectrum 
process to the data the plot details on the right-hand side will change to show 
spectrum units and the co-ordinates reported on the status bar, as the mouse 
moves, will show x position and frequency, instead of x and y co-ordinates.

 A default style printout of a graphics plot can be made to any scale 
or print size using the File menu. You can choose whether you want to : (a) 
plot the whole data set, (b) a specific block, or (c) just what you see on 
screen. Graphics plots, palette scale-bars, north symbols histograms and 
distance scale-bars can also be saved to files. These can subsequently be 
imported into the publish view, at a specific scale, for publishing. 
Alternatively, you can use the saved bit-map for importing into other 
Windows packages. An animation facility on the Graphics menu allows  
different views of one data set, or data sets from different instruments over 
the same area, to be visually compared. 

Publishing
 Once you have processed your data and set the graphics plotting parameters you can save this image, along with scale bars, 
north direction and histogram for use in the publishing mode. This mode allows you to tailor the printout to your own requirements, 
rather than using the default presentation of the standard graphics view, allowing you, for example, to choose a border and add text in 
various fonts and sizes, select a north direction symbol. Images may be positioned, rotated and scaled to your liking. More than one 
image can be incorporated in the document, for example images from different sites, different graphics types (eg shade and trace plots) 
and even your own logo. The published graphics image is not just a screen grab with limited resolution, but a properly regenerated plot 
showing full detail on large size printers. 

Form for defining shade palettes

Publishing 
View
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Processing
 Processing includes a comprehensive range of functions for manipulation of 
all data types, together with specific routines to correct for data collection artefacts such 
as edge matching and drift correction. Some functions are designed specifically for 
Geoscan Research instrumentation but all may be equally applied to other 
instrumentation data sets. Mathematically, any real bipolar or monopolar two 
dimensional data array may be processed.

 A processing tutorial is included in the instruction manual, together with 
"QuickStart" cards which guide you through the processing sequence appropriate for 
each data type. Both assist new users in becoming an adept and competent processor 
with a minimum of effort, and help to prevent inappropriate processing of the data.

 Processing functions can be applied to the complete data set or any specific 
rectangular area, known as a block. You can specify a block either by entering co-
ordinates in a form or, by selecting the area using the mouse. This block remains 
operational until turned off. You can select process functions and process area from the 
menu, or more conveniently from the process toolbar.

 Processing history is stored with each data file. This records function applied, 
the chosen parameters and co-ordinates of any selected block, giving full traceability. A 
floating form, "Latest History" shows the last four processes applied and you can 
instantly switch to the history view to see a full listing of all processes. The process 
history shows a dotted dividing line between those processes that have been saved and 
any new functions that have been applied but not saved. History comments can be 
added, inserted or deleted when the history view is shown. Functions include :

Numeric Functions
 Add, Multiply, Absolute, Power, Clip, Compress, Search and Replace, 
Randomise are general purpose numeric tools with a variety of applications. Some 
examples follow though they are by no means limited to these. The Add function can be 
used to edit a single data point or bias a block of data. Multiply can be used to normalise 
data or convert resistance to resistivity. Absolute can be useful in the generation of 
magnetic-resistance correlation plots. Power can be used to convert resistivity to 
conductivity. Clip can be used to limit data to specified maximum and minimum values 
for improving graphical presentation and also forms a useful pre-process procedure for 
many other functions. Compress can be used to fit data within the dynamic range of a 
display device or printer, allowing both large and small magnitude features to be visible 
at the same time. Search and Replace can be used, in conjunction with Clip, to convert 
regions strongly perturbed by nearby iron fences, pipelines etc. into dummy regions, 
allowing other statistical functions to perform correctly. Randomise may be used for 
introducing a controlled amount of noise so that surveys performed at different times or 
with different instruments visually match.

Cut and Combine
 This function provides Cut and Paste, Add, Subtract and Multiply operations 
between two data sets (grid and composite). This can be applied between any block of 
source data and positioned at any location in the other data set. Applications include 
merging data sets, splitting data sets, generation of correlation plots between data sets 
etc. Another powerful application is to examine the effect of a process function (by 
subtracting the original data set), thereby ensuring that the process function has been 
applied with the correct parameters (see figures on opposite page).

Block Statistics report form, with 
block outlined on the shade plot

Floating “Latest History” form

Cut and Combine form
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Deslope
 Removes a linear trend within a data set. It is typically used to correct for drift in 
gradiometer data where the use of the Zero Mean Traverse function is inappropriate.

Despike
 Automatically locates and removes random spurious readings present in resistance data and 
locates and removes random "iron spikes" often present in gradiometer data.

Destagger
 Corrects for displacement of anomalies caused by alternate zig-zag traverses which are 
sometimes observable in gradiometer data.

Edge Match
 Used to remove grid edge discontinuities which may be present in Twin electrode resistance 
surveys as a result of improper placement of the remote probes.

High Pass Filter
 Used to remove low frequency, large scale spatial detail, typically  a slowly changing 
geological "background" response commonly found in resistance surveys.

Interpolate
 Increases or decreases the number of data points in a survey (linear or sinx/x method). 
Increasing the number of data points can be used to create a smoother appearance to the data. 
Interpolate can also be used to make the sample and traverse intervals of differently sampled 
composites match, prior to combining them.

Low Pass Filter
 Removes high frequency, small scale spatial detail, useful for smoothing data or for 
enhancing larger weak features.

Median Filter
 Automatically locates and removes spurious readings present in survey data and smoothes 
the data at the same time. Most useful for high sample density data.

Periodic Defect Filter
 Used to remove periodic features which may be present in the soil (eg plough marks) or 
which may be introduced as defects during gradiometer data collection.

Spectrum
 Analyses the frequency spectrum of the data, splitting it into Amplitude, Phase, Real or 
Imaginary components. The Amplitude spectrum can be used to identify periodic defects in 
gradiometer data which can then be removed with the Periodic Defect filter.

Statistics
 Statistical analysis of any block of data in a data set : localised mean, standard deviation, 
minimum, maximum and localised histogram (this is additional to the floating statistics report for the 
whole data set). Statistics can help determine appropriate parameters for other process functions. The 
report form can be positioned anywhere on screen or minimised and can be retained whilst a new data 
set is loaded, for statistics comparisons.

Standard Deviation or Variance Map
 Replaces the data set by either the local variance or local standard deviation. A graphics 
plot of this new data set indicates areas of statistically different activity.

Wallis Filter
 Provides histogram equalisation that emphasises low value readings and compresses high 
value readings.

Zero Mean Grid
 Sets the background mean of each grid within a composite to zero. It is useful for removing 
grid edge discontinuities often found in gradiometer or similar bipolar data.

Zero Mean Traverse
 Sets the background mean of each traverse within a grid to zero. It is useful for removing 
striping effects in the traverse direction which can occur in gradiometer data. This 
also has the effect of removing grid edge discontinuities at the same time (see adjacent 
figures).

Raw Gradiometer Data

Zero Mean Traverse Corrected

Despiked

Spikes Identified



Warranty
This program and accompanying instruction manual 
are supplied “as is”, without warranty as to their 
performance, merchantability, or fitness for any 
particular purpose. The entire risk as to the results 
and performance is assumed by the user. All 
specifications subject to change without notice.
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Single, Network or Educational Versions 
 Geoplot is normally supplied for one user operating on a stand-alone PC or a 
network. Multiple user versions (5 and 10) are available for use on client-server 
network systems. A multiple user (25) educational version, with restricted 
functionality, is available for use on client-server networks. Functions that are disabled 
are : New Input Template, Open Input Template, Download Data, Keyboard Input, 
Import Data, Export Data and Create Pseudo-sections. There are no other restrictions.

Upgrades and Support
 Geoplot is undergoing constant improvement and refinement - the latest 
version may be downloaded from our website. Future upgrades will include interfaces 
to new instruments, together with new processing and presentation facilities. If there 
are specific facilities not mentioned above that users would like to be included in 
future versions then we would be happy to consider suggestions. A charge will be 
made for upgrades. Full technical support is provided free of charge.

Hardware Requirements
 Operating system should be: Win 3.1, 3.11, 95, 98, ME, NT4, 2000, XP, 
Vista (32 bit), Win 7(32 bit). Geoplot will not run directly on 64 bit systems. If you 
have a 64 bit operating system then you can either create a dual boot system with a 32 
bit version of Windows such as XP or Win 7(32 bit) or create a virtual PC using, for 
example, VMWare Player 5, VMWare Workstation or Virtual Box. Virtual PC2007 
and XP Mode supplied as part of Win 7(64 bit) does not allow Geoplot to run due to 
problems with it’s handling of USB devices. 

 Minimum hardware is 266 MHz Pentium II processor, SVGA display. An 
RS232 communication port is required if data is to be downloaded from instruments 
into Geoplot 3.0 - if there is only a USB port available then a USB to serial port 
adapter may be used. A 3.5 inch floppy disk drive may be required (below).

 Geoplot 3.0 consists of  three items: (a) CD with installation code, (b) 
comprehensive instruction manual with tutorial and (c) softare protection -  this is 
provided as either a USB or LPT hardware dongle, or a software authorisation on 
floppy disk. USB dongles will be supplied unless an alternative is requested. The 
software authorisation is transferred to your hard disk from a floppy disk (internal 
drive recommended) or can be transferred to another PC via the floppy disk. 


